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About this book

This document describes Rational Portfolio Manager 7.1 release notes. It covers
new features added in this release, a list of known problems, and problems that
have been fixed in this release.

Who should read this book

This document is intended for any Rational Portfolio Manager user.

Proprietary notice

Licensed materials — Property of IBM

© Copyright IBM Corp. 1997, 2007

US government users restricted rights — Use, duplication, or disclosure restricted
by GSA ADP schedule contract with IBM Corp.
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Chapter 1. About this release

Documentation roadmap

All documents accompanying this release are available as part of product
installation media on the Quick Start CD, or from the IBM® Publications Center.

To locate the Publication Center for your area, go to http://www.ibm.com and
search on the term Publications Center. Follow the instructions on the IBM
Publications Center Web site to locate individual documents. Table 1 describes each

of these documents:

Table 1. Rational Portfolio Manager 7.1 documentation

Document

Description

Installation and upgrade guide for
Windows®

Provides information about installing and
migrating Rational® Portfolio Manager with
DB2° or Oracle databases on Windows.

Installation and upgrade guide for UNIX®

Provides information about installing and
migrating Rational Portfolio Manager with
DB2 or Oracle databases on UNIX systems.

Post installation administration guide

Refer to this document for all
post-installation activities, including sharing
the settings, configuring default calendars
and currencies, and so on.

Rational Portfolio Manager/Rational
ProjectConsole integration guide

Refer to this document for integration
between Rational Portfolio Manager and
Rational ProjectConsole ™.

Rational Portfolio Manager/Rational
ClearQuest integration guide

Refer to this document for integration
between Rational Portfolio Manager and
Rational ClearQuest®.

Rational Portfolio Manager/Rational
RequisitePro integration guide

Refer to this document for integration
between Rational Portfolio Manager and
Rational RequisitePro®.

Web Services API guide

Refer to this document for the installation
and use of Rational Portfolio Manager Web
Services APIL

Rational Portfolio Manager Data Warehouse
guide

This document provides user and reference
information for the Rational Portfolio
Manager data warehouse, including how to
configure reporting tools for the warehouse,
the role of the data warehouse staging area,
and reference information on mapping to the
Rational Portfolio Manager database.

Latest documentation update for Rational RequisitePro Integration

The following section describes the latest documentation update that is not
included in the Rational Portfolio Manager/Rational RequisitePro Integration

guide.
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Rational RequisitePro Web Services installation using Rational
Web Platform (RWP)

Prerequisites

* Rational RequisitePro 7.0.1 installed along with RequisiteWeb on the system.
(Earlier versions are not supported.)

RequisitePro Web service application configuration

When you install RequisiteWeb, the Rational Web Platform (RWP) and
RequisitePro Web service are also installed. In order for the Web service to function
properly, you must perform the following configuration steps.

Using RWP as the application server

If you are using RWP as the application server, note the following in the supplied
Rational RequisitePro Integration Guide:

* The external application servers mentioned in the System Requirements section on
page 2 are not required.

* RequisitePro Client for Web, mentioned in the Rational RequisitePro Components
Installation section on page 3, is mandatory.

* The instructions contained in the section Deploying the Rational RequisitePro Web
Services EAR file in pages 3 to 8 are not relevant.

* The RequisitePro server port number, shown in Figure 7 on page 12, must be
specified as the default port number 11080.

Perform the following steps to use RWP as the application server. These include:
* Configuring the environment variables

* Replacing the proxies.jar file

To configure the environment variables:

1. To edit the file, open the resources.xml file located under: Common\rwp\
EmbeddedExpress \profiles\ profile2\ config \ cells\ DefaultNode \nodes\
DefaultNode\servers\serverl\

2. Enter the following text between the <xmi:XMI></xmi:XMI> tags:

<resources.env:ResourceEnvironmentProvider
xmi:id="ResourceEnvironmentProvider_1166438141305"
name="reqproprovider”>

<factories xmi:type="resources.env:ResourceEnvEntry”
xmi:id="ResourceEnvEntry_1166445307290"
name="REQPRO_CATALOG_PATH" jndiName="REQPRO_CATALOG_PATH"
referenceable="Referenceable_1166445249482">

<propertySet xmi:id="]2EEResourcePropertySet_1166445351917">
<resourceProperties xmi:id="]J2EEResourceProperty_1166445351917"
name="REQPRO_CATALOG_PATH" type="java.lang.String”"
value="%REQPRO_INSTALLATION_DIRECTORY \RequisitePro\ReqWeb\
projects\catalog.txt” required="false" />

</propertySet>

</factories>

<factories xmi:type="resources.env:ResourceEnvEntry”
xmi:id="ResourceEnvEntry_1166445378740" name="RJCB_DLL_PATH"
jndiName="RJCB_DLL_PATH" referenceable="Referenceable_1166445249482">
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<propertySet xmi:id="]2EEResourcePropertySet_1166445422846">

<resourceProperties xmi:id="]J2EEResourceProperty_1166445422846"
name="RJCB_DLL_PATH" type="java.lang.String" value="
%REQPRO_INSTALLATION_DIRECTORY \Common\R]JCB.dIl"
required="false" />

</propertySet>

</factories>

<factories xmi:type="resources.env:ResourceEnvEntry”
xmi:id="ResourceEnvEntry_1166445447477"
name="REQPRO_BRIDGE_DLL_PATH"
jndiName="REQPRO_BRIDGE_DLL_PATH"
referenceable="Referenceable_1166445249482">

<propertySet xmi:id="]2EEResourcePropertySet_1166445486189">

<resourceProperties xmi:id="J2EEResourceProperty_1166445486189"
name="REQPRO_BRIDGE_DLL_PATH" type="java.lang.String"
value="%REQPRO_INSTALLATION_DIRECTORY \RequisitePro\bin\
ReqProBridge.dll” required="false" />

</propertySet>

</factories>

<referenceables xmi:id="Referenceable_1166445249482"
factoryClassname="com.ibm.reqpro.config.StringFactory”
classname="java.lang.String" />

</resources.env:ResourceEnvironmentProvider>

3. Replace all instances of the environment variable
“%REQPRO_INSTALLATION_DIRECTORY” by supplying the exact path where
Rational RequisitePro is installed.

4. Save and close resources.xml.

To replace the proxies.jar file:

1. Copy the proxies jar file from RequisitePro installation directory
'RequisitePro\lib' to the following directory:

Common\rwp\EmbeddedExpress\ profiles\profile2 \installed Apps\
DefaultNode\ WebServices.ear\RequisiteProWebservice.war \WEB-INF\lib\

Migrating from Rational Portfolio Manager 7.0.5.5

The Staffing feature (partially assigning a resource towards a profile) included in
release 7.0.5.5 of Rational Portfolio Manager will not be available in this release.
This feature will be implemented in the upcoming release of Rational Portfolio
Manager.

Security settings changes

This section describes the new or modified security settings in version 7.1 of IBM
Rational Portfolio Manager. For more information about security settings, see the
security section of the Rational Portfolio Manager online help.

New security rights for accessing reports on Common
Reporting
New security rights have been added that control access to individual reports from
Common Reporting. To grant these security rights:
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Log in to Rational Portfolio Manager as an Administrator.

From the navigation bar, select Application Administration.

Click the Security tab.

From the WBS tab, expand the Project Group folder and select a security role.
In the right frame, expand Portfolio Viewer, then Data Warehouse.

ook wn =

Grant security rights by selecting the check boxes of group 1 to 31.

Latest supported operating environments

4

Table 2 lists the operating environments that Rational Portfolio Manager supports.

Table 2. Rational Portfolio Manager latest supported databases

Hardware

Database Version Operating System Architecture

DB2 8.2 % AIX® 5.2 (32-bit) P5

DB2 8.2 AIX 5.2 (64-bit) P5

DB2 8.2 AIX 5.3 (32-bit) P5

DB2 8.2 AIX 5.3 (64-bit) P5

DB2 8.2 Red Hat Linux® AS | Xeon™
Version 4 (32-bit)

DB2 8.2 Red Hat Linux AS Xeon
Version 4 (64-bit)

DB2 8.2 SuSE Linux 9.2 Xeon
(32-bit)

DB2 8.2 SuSE Linux 9.2 Xeon
(64-bit)

DB2 8.2 Solaris 8 (32-bit) SPARC

Oracle 9.2.0.8 AIX 5.2 (64-bit) P5

Oracle 9.2.0.8 AIX 5.3 (64-bit) P5

Oracle 9.2.0.8 Red Hat Linux AS Xeon
version 3 (32-bit)

Oracle 9.2.0.8 HP-UX 11i Version 1 | HP PA-RISC
(11.11) (64-bit)
(update 4)

Oracle 10.2.0.2 AIX 5.3 (32-bit) P5

Oracle 10.2.0.2 AIX 5.3 (64-bit) P5

Oracle 10.2.0.2 HP-UX 11i Version 1 |HP PA-RISC
(11.11) (64-Bit)

Oracle 10.2.0.3 Red Hat Linux AS Xeon
version 3 (32-bit)

Oracle 10.2.0.3 Red Hat Linux AS Xeon
Version 4 (32-bit)

Oracle 10.2.0.3 Red Hat Linux AS Xeon
Version 4 (64-bit)

Oracle 10.2.0.3 SuSE Linux 9.2 Xeon
(32-bit)

Oracle 10.2.0.3 SuSE Linux 9.2 Xeon
(64-bit)
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Table 2. Rational Portfolio Manager latest supported databases (continued)

Hardware

Database Version Operating System Architecture

Oracle 10.2.0.3 Solaris 9 (64-bit) SPARC
(update 6 or later)

Oracle 10.2.0.3 Solaris 10 (64-bit) SPARC

DB2 8.2 % Windows 2000 FP 4 | Xeon, Itanium® 2
(32-bit)

DB2 8.2 Windows 2003 5.2 Xeon, Itanium 2
(32-bit)

Oracle 9.2.0.8 Windows 2000 FP4 Xeon, Itanium 2
(32-bit)

Oracle 10.2.0.3 Windows 2000 FP 4 | Xeon, Itanium 2
(32-bit)

Oracle 10.2.0.3 Windows 2003 Xeon, Itanium 2
(32-bit)

* Also known as 8.1 FP 14.

Note: The versions of DB2 and Oracle identified are the latest versions that are
certified. In general, previous maintenance releases of DB2 and Oracle are

also supported. Consult IBM Customer Support for any queries on previous
supported versions.

Table 3 lists the application servers that Rational Portfolio Manager supports.

Note: Oracle Application Server and BEA WebLogic Application Server are not
certified with this release of Rational Portfolio Manager.

Table 3. Rational Portfolio Manager supported application servers

Application Server Version
WebSphere® 5.1, 6.0 and 6.1
Apache Tomcat 5.5

Table 4 lists the integrations that Rational Portfolio Manager supports.

Table 4. Rational Portfolio Manager integrations support

Application

Version

Rational ClearQuest

7.0

Microsoft Project

2002 and 2003 (with MDAC 2.6 or higher)

Rational Method Composer

7.1

Rational ProjectConsole

7.0.0.1 and 7.0.1

Rational RequisitePro

7.0.1

BIRT reporting

If you want to design and test BIRT reports, you should download the BIRT Report

Designer from the following URL:

Chapter 1. About this release
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http:/ /www.eclipse.org/downloads/download.php?file=/birt/downloads/drops/
R-R1-2_1_2-200702271000/birt-rcp-report-designer-2.1.2.zip

New features in 7.1

6

This section describes the new features in version 7.1 of Rational Portfolio
Manager.

Rational Portfolio Manager data warehouse

Beginning with version 7.1, Rational Portfolio Manager includes a data warehouse
capability for use in storing data, querying, and creating pivot reports. The data
warehouse offers these benefits:

* Open architecture

* The ability to create your own extract, transform, and load (ETL) processes
through the creation of star schema

* Secure access to Rational Portfolio Manager data using third-party tools

e Predefined data warehouse star schemas for a subset of current Rational
Portfolio Manager pivots

* Fully documented Rational Portfolio Manager staging tables and data warehouse
star schemas

* The ability to uses existing tools and replication technologies without
middleware

* Improved performance
* The ability to create trend charts

For complete documentation, including installation instructions, see the Data
Warehouse Guide and Installation and Upgrade Guide on the Quick Start CD.

Rational Portfolio Manager TeamMember edition

Beginning with version 7.1, Rational Portfolio Manager supports an online
interface called Rational Portfolio Manager TeamMember. This Web-based
application features hyperlinks to application areas dedicated to project activities of
interest to project resources assigned to tasks as either task responsible or task
team member. The Rational Portfolio Manager TeamMember contains the following
application areas:

Timesheet: A representation of the workstation client’s timesheet view which users
can utilize to report time on assignments, supporting the following features:

* Weekly access based on reporting period selection
* Creation of personal and administrative tasks

* Special time reporting (also known as overtime)

* EETC and percent complete automatic update

* Timesheet saving and submission

Scheduled Work: A grid view showing all tasks currently assigned to the resource
or otherwise visible as participant. This view is used to perform the following
actions:

* Start work on assignments by allowing resources to add tasks to their timesheet
 Tracking tasks to parent projects by using the Show Context window

* Document task details by adding comments and appending documents by using
the Task Properties editor
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Scope Elements view: A grid view resources can use to report exceptions during
project execution using common Rational Portfolio Manager scope elements such
as risks, defects, requirements, and issues. Similar in layout to that of the
Scheduled Work view, resources can use a properties editor to fully document each
reported exception and append documents.

Documents view: A centralized document management view. Contrary to the
previous two views, in which emphasis was either on task or scope element
records, this view lists all documents currently visible to the user, either as
originator or participant. The Show Context window displays project element
association. Users can also utilize the properties editor typical to any record to add
context information to each document container and track documents each time
they are accessed.

Rational RequisitePro integration

The goal of the Rational Portfolio Manager (project management) integration with
Rational RequisitePro (requirements management) is to link requirements with
project planning and tracking to help clients achieve the following goals:

* Achieve improved traceability by mapping requirements to project tasks without
making significant changes to existing processes and practices.

* Ensure that the appropriate roles are working with the appropriate tools; for
example, project managers working with Rational Portfolio Manager and project
analysts working with Rational RequisitePro.

* Provide project managers with greater visibility and insight into the relationship
between development activities and the requirements from Rational
RequisitePro, and facilitate project analysts” ability to trace requirements to
corresponding tasks in Rational Portfolio Manager.

* Automate Rational RequisitePro requirement updates into Rational Portfolio
Manager requirements; this includes creating, modifying, and deleting.

For more information, see the IBM Rational Portfolio Manager/IBM Rational
RequisitePro Integration Guide.

My Resources tab

The My Resources tab in the Staffing view provides access to the most commonly
used resources across projects without having to search for them. The list of
resources available in this tab is generated by adding resources from the Results
Set tab, the Project Resources tab, or from the Resources Management view by
adding individual resources or a pool of resources.

Project health indicators

The project health indicator is a color representation of the general health of a
project. These colors are determined by a series of threshold values specified in the
bubble Settings window. The following indicators represent specific aspects or
dimensions of a project:

* Cost health

* Revenue/Benefits health
¢ GP/Savings health

* Schedule health

* Scope Elements health

* Scorecards health
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Date format in Rational Portfolio Manager

IBM Rational Portfolio Manager uses the Windows short date format to display
dates on data such as pivots, reports, grids, inspectors, portlets, and so on,
throughout the application. The short date format is specified by the user in the
Regional and Language Options window of the Windows Control Panel.

Grouping attributes

To organize your attribute filters, you can group them together into folders. To
create an attribute group container:

1. In the attribute window, right-click By Attributes and select New > Custom
Filter Group.

A folder is created under the By Attributes filter.
2. Enter a name for this filter group.

3. Optional: Organize your attribute filters by dragging the attributes you want
into the newly created folder.

Editing attribute filters

In this version of Rational Portfolio Manager, you can edit previously saved
attributes. To edit a saved attribute:

1. Expand the By Attributes category.

2. Right-click the attribute filter you want to edit and select Edit Attribute Layout.
3. In the Attribute Filter window, add or remove the desired attributes.
4.

Click Save. You can also enter a new name in the Attribute Layout Name field.

Attaching attribute filters to view layouts

You can attach attribute filters to your view layouts; every time you start the
application, the attribute filter layout will be displayed. To attach an attribute filter
to the current layout:

1. Expand the By Attributes category.

2. Right-click the attribute filter you want to attach to the view layout and select
Attach to Current Layout.

To detach the attribute filter from the view layout:
1. Expand the By Attributes category.

2. Right-click the attribute filter that is attached to the view layout and select
Detach from Current Layout.

Read-only fields

The description view read-only fields (due to security or the layout definition) are
displayed in a light shade of grey to differentiate between the editable fields.
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Multi-select modify feature

Identification

Marme Requirement
Fank, 500
Pricrity S00

Reference Mumber

External Ref #

Client Mame

Asset Mame

Asset Code Maone
Duplicate #

Element Security  |Project Level
Target Date

Esk, Skark 10/10/2006
Est. Finish
Skate Open

It is now possible to select multiple items of the same type in the Work
Management view and modify them. To modify multiple items in the Work
Management view:

1.
2.

From the navigation bar select Work Management.

In the Work Management view, select multiple projects, deliverables, tasks, or
milestones that you want to modify.

Right-click and select Edit > Modify. The Modify window opens.
For projects and deliverables, you can modify priority, state, and estimated start

and finish dates in the Identification portlet. Estimated start and finish dates
are excluded for tasks and milestones.

In the Attributes portlet, you can add, remove, or edit any existing attributes.

Chapter 1. About this release
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Modify

Identification =
Priority 0] =
State Mone

Esk, Stark

Est. Finish

~ Attributes =

Categaory Classification > Attribute B X =
Attributes Input Type |Single/... |Desu:ri|:utiu:un |A

Test Attributes

# B oa

F- B Test Eay .

M 2T e #d nadTa M
I add 4 Remaove

]
Zategory | Classification

| Assigned Attribute

[i[ i | [l]

ok Cancel |

5. Click OK, and then click OK again to confirm your changes. The system checks

out the selected elements, applies the changes, and displays the following
window for confirmation.
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-
Modify

Applying changes to selected elements._ .

hlarme ¢ [=]|wBs ID [« ||Progress v
| Task 10 Done.

Task2 1.4 Dane.

Task 1.9 Dane.

LCloge

6. Click Close and return to the Work Management view.

Note: The modify element security right is enforced, ensuring that only those
elements with the proper security rights can be modified.

Displaying multiple description views

It is now possible to open a separate description view for any element in the Work
Management, Scope Management, Resource Management, Clients/Cost Centers,
and Asset views. To open a description view in a new window:

1. Select an element from any of the aforementioned views.
2. Right-click and select Open in New Window.

3. Check out the description view and modify it as necessary.
4

. Close the description view by clicking the X button in the toolbar or selecting
Exit from the File menu.

Copy as link feature

You can use the copy as link feature to copy the link of any element to the
clipboard and paste it into any Rich Text Field (RTF) portlet for execution. Security
permitting, clicking the link in the RTF portlet opens the description view of that
element in a new window. To use the copy as link feature:

1. Right-click an element and select Copy as Link.
2. Open the description view of another element.

3. Expand an RTF portlet and paste the link.
4

. Click the link to open the description view of that element in a new window.

WBS inline editing

Using Work Management inline editing, you can update data in the following
fields:

¢ Workflow Collaboration band > State header

* Quick Status band > Start header (only for tasks and milestones in proposed
mode)
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* Quick Status band > Finish header (only for tasks and milestones in proposed
mode)

* Quick Status band > Dur. header (only for tasks and milestones in proposed
mode)

* Resources band > Assigned header

Rational ClearQuest scheduled synchronization

It is now possible to schedule a synchronization job for Rational ClearQuest
projects in Rational Portfolio Manager. When enabled, synchronization happens for
each project at the interval of time specified in the ClearQuest Integration portlet.
By default, the scheduled synchronization is disabled. To enable the scheduled
synchronization:

1. From the Work Management view, double-click a project that has a Rational
ClearQuest mapping profile to open its description view.

2. Check out the description view and expand the ClearQuest Integration portlet.

3. Select the down arrow in the Scheduled Synchronization field and select an
interval of time required to perform the synchronization.

ClearQuest Integration

scheduled Synchronization  Disabled hd
Mapping Profile Dicabied
Last Synchronized 1 hiour
swnchranize Preced 2 hours
wnchronize Precedence i
1 davy
2 days

Exporting Rational Portfolio Manager tasks to Rational
ClearQuest

Using this feature, you can export tasks that have been created in Rational
Portfolio Manager as Rational ClearQuest records. Based on the default mandatory
values for the Rational ClearQuest record types saved in the mapping profile, a
new Rational ClearQuest record is created. This newly created Rational ClearQuest
record will be linked to the Rational Portfolio Manager task. To use this feature:

1. From the Work Management view expand a project and select the task that you
want to export as a ClearQuest record.

Note: The project must have a Rational ClearQuest mapping profile assigned.
2. Right-click the task and select ClearQuest Integration > Export Record.
3. Enter your Rational ClearQuest log in information.

4. In the export window, select the Rational ClearQuest record type from the
drop-down list.

5. Click Export to start the Rational ClearQuest Web client for the selected record.
6. Fill in the required fields and then click Save.

After the Rational ClearQuest record is created and saved, you can synchronize the
task in Rational Portfolio Manager.
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Creating project scope elements from Rational ClearQuest
records

Using this feature you can import Rational ClearQuest records into Rational
Portfolio Manager as scope elements.

Dragging enhancement

When performing a dragging operation in any Rational Portfolio Manager tree
views, there is a new visual indicator (a black L-shaped line) that shows where the
item in the tree is being dropped.

= W, T Project
=@ Deliverable

@ Task,

79 (Deliversble?
by ) Task
==

Cannot Drop icon
When you attempt to drag an item to a location where the item cannot be moved,
the following cursor is displayed.

= W T Project
=@ Deliverable

@ Task

Sibling move

When performing a sibling move operation in any Rational Portfolio Manager tree
views at the same level, there is a visual indicator (a blue line) that shows where
the item in the tree is being dropped.

= W, T Project
- @5 Deliverablez

% T8 e
L GO pelierptle
@ Task,

79 Deliverable3

Note: Holding the Shift key after clicking the item will change the drag operation
to a sibling move mode.

Enhancements to the Rational Method Composer integration

You can use the Rational Portfolio Manager and Rational Method Composer
integration to integrate process and project management. You can customize and
configure a process in Rational Method Composer, including work breakdown
structures (WBS). Information about exporting Rational Method Composer
structures is available in Rational Method Composer product documentation. After
it is exported to a process XML file, you can import the work breakdown structure
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into Rational Portfolio Manager for use in creating a new project or proposal. You
can use the features of the Rational Portfolio Manager integration with Rational
Method Composer to perform the following actions:

* Import roles associated with tasks, including the Rational Method Composer
roles Additional Performer and Assisted by. In Rational Portfolio Manager,
these are mapped to Task Team Member and Task Participant respectively.

* Import template items for dependencies, including predecessor and successor
tasks.

* Update existing templates to synchronize with changes made to corresponding
templates in the Rational Method Composer. These include additions or
deletions of task descriptors, work products, roles or performers, and security
levels for roles or performers.

* Create new proposals directly from templates imported from Rational Method
Composer delivery processes. The delivery process describes a complete project
life cycle and is commonly used as a reference for creating projects with similar
characteristics. In earlier releases, delivery processes were imported as summary
tasks. They are now imported as proposals, so that you can reuse the template
with the Adopt option to create new proposals.

* Import effort estimates. Rational Method Composer version 7.1 supports the
ability to perform effort estimates. When you import process XML files with
estimated efforts, these values are imported in Rational Portfolio Manager.

* Create work product placeholders in templates. Work products can be
Outcomes, Artifacts, Deliverables, and so on. The imported work product
contains information about its type, and is associated with URLs that point to
the actual published content corresponding to that work product. For example, if
a work product is an artifact, it has a URL associated with it, with the name
Artifact specifying its type. Any template references for the work product are
added as URLs under the document placeholder.

¢ Import a published Web site from Rational Method Composer to Rational
Portfolio Manager with greater efficiency. You can now import a Web site by
specifying it in a Rational Method Composer template, or while importing a
Rational Method Composer template.

Table 5. Rational Method Composer version support for integration features

Features Rational Method Composer version

Import dependencies in Rational Method All Rational Method Composer versions

Composer supporting the Rational Portfolio Manager
integration (Rational Method Composer 7.0,
7.0.1,7.1)

Import Rational Method Composer Template | All Rational Method Composer versions

of delivery process as proposal into Rational |supporting the Rational Portfolio Manager
Portfolio Manager integration (Rational Method Composer 7.0,
7.0.1,7.1)

Map all roles of Rational Method Composer |Rational Method Composer 7.1
task descriptor to corresponding Rational
Portfolio Manager task

Update Rational Portfolio Manager template | Rational Method Composer 7.1
if same template is imported in Rational
Portfolio Manager
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Copying resources in the Resource Management view

In this version of Rational Portfolio Manager, you can copy resources in the
Resource Management view from one pool to another, or within the same resource
pool. To copy resources:

—_

From the navigation bar, select Resource Management.

Expand the resource pool that you want to copy the resources from.
Right-click a resource and select Edit > Copy.

Right-click the same pool or a different pool and select Edit > Paste.

S A

In the Copy Resource window, enter a unique resource logon name in the field
and then click OK.

f 1

Copy Resource

Enter unique Besource Logon name

(] | Cancel

Note: If the resource name entered in the field is already used in the system,

the following error message will be displayed and the copy operation
will be cancelled.

-,

200010

Resource Logon Mame must be unique across the same Repository

Copying resources by using the drag-and-drop feature
To copy and paste resources by using the drag-and-drop feature:

1. From the navigation bar, select Resource Management

2. Expand the resource pool that you want to copy the resources from.
3. Select the resource and press and hold the Ctrl key.
4

. Drag the resource onto the same pool or a different pool when the following
cursor is displayed.

= (), {Mahmaud's dacumentation pool o
+ {} David Beu:khal% [ Sally Hehir
HT=

5. In the Copy Resource window, enter a unique logon resource name in the field,
and then click OK.

Adding and removing multiple resource assignments

It is now possible to assign work to multiple resources at the same time. To assign
work to multiple resources:

1. From the Work Management view select the WBS element that you want to
assign resources to.
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On the toolbar, click the Staffing icon, and then click Search/Assign.
Search for resources.

In the Results Set tab select multiple resources from the top frame by pressing
Shift or Ctrl as you select your resources.

Click Assign.

Note: The resources that are assigned to elements stay in the upper frame.

Optional: Remove multiple resources by selecting the resources from the
bottom frame and clicking Remove.

In the Remove Assignment window select the Apply to All check box and then
click Remove or Replace Resource with Profile.

Note: If Apply to All is not selected, the Remove Assignment window will
open for each of the selected resources, prompting for a confirmation to
delete.

Approve/reject multiple timesheet records

In this version of Rational Portfolio Manager, you can select multiple timesheet
records in the Timesheets view and approve or reject them simultaneously. To
approve or reject multiple timesheet records:

1.
2.
3.

From the navigation bar, select Timesheets.
From the Filter area select one of My Teams' Work filters.

From the date selection in the toolbar, select a week that has a submitted
timesheet.

Expand the projects to the resource level.
Press Shift or Ctrl keys as you select multiple resources.

Right-click and approve or reject the timesheet by selecting the option from the
pop-up menu.

T ‘;w" 0.1415
+ 1 Ma — : = [
i ) '-.-'-.-'E Approve Selected Resources' Timesheets

= ‘Kw" Reject Selected Resources' Timesheets

Note: If you select only one resource, you must check out the timesheet before you

can approve or reject it. Selecting multiple resources does not require that
the timesheets be checked out.

Sharing personal settings and layouts

In this version of Rational Portfolio Manager, you can customize and create view
layouts and share them with other users across the repository. Imported settings
could eventually be published to the server by an administrator. The following
settings can be shared:

Tree layouts

Investment map configurations
OLAP pivot layouts

OLAP pivot graphs

Report templates

Portlet layouts (description views)
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Saving, sharing, and importing layouts and personal settings
To share layouts, perform the following actions:

* In any tree views right click on the band and select Share this Layout.

* In any description views click the Share icon in the toolbar and select Share this
Layout.

¢ In the Investment Maps view right click in the map selector and select Share
this Setting.

* In OLAP Pivots right-click the band and select Share this Layout.
* In pivot graphs right-click the graph selector and select Share this Graph.

* In Reports view right-click your customized report and select Share -> Share
this Report.

After you share a layout, the Save window opens. To save a layout, enter a name,
specify a location, and then click Save. You can then send your saved layout to
other users for import by e-mail or as a document attachment in Rational Portfolio
Manager.

Note: Shared layouts and settings can only be imported to those views where it
was originally saved. For example, a description view layout cannot be
imported as an OLAP pivot layout.

To import a layout or setting, navigate to the view from which you want to import
the layout or setting, and then perform one of the following actions:

* In any tree views right click on the band and select Import Layouts.

* In any description views click the Share icon in the toolbar and select Import
Layouts.

* In the Investment Maps view right click in the map selector and select Import
Settings.

e In OLAP Pivots right click on the band and select Import Layouts.
* In pivot graphs right click in the graph selector and select Import Graphs.

* In Reports view right click on your customized report and select Share ->
Import Report.

After you perform any of the previously described actions, the Import window
opens. Browse for the file that you want to import and then click Open.

Opening element's description views from Dependencies and
Duplicate portlets

It is now possible to open the description view of Rational Portfolio Manager
elements from the Dependencies portlet, Dependencies view, and the Duplicates
portlet. You can open the element description view in a new window by
right-clicking the element and selecting Open in New Window.

Viewing an element's hierarchy from a flat list view

The Work Management view displays a flat list of all elements from all projects as
a result of a WBS search or when a certain filter is applied to the view. Some of
these elements could potentially have the same name; therefore, it is beneficial to
view the element’s hierarchy. To view an element’s hierarchy:
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1. From the Work Management view that displays a flat list of elements, right
click on the element and select Open in Element View (security permitting).
The view displays the element with all its parent items and any children, if
available.

Note: All parent items are displayed in grey text. You can open the description
view for these parent items, but the view is read-only.

2. Close the element view and return to the main WBS view by clicking the Close
icon in the toolbar.

Customize window to display tabs for attributes and custom
fields

The Attributes and Custom Fields tabs are added to the Customize window that
you can use to drag attributes and custom fields columns to Work Management,
Scope Management, Documents, Resources Management, and Assets views.
Selectable attributes and custom fields are related to the active view. For example,
in the Assets view, only those attributes and custom fields that are directly related
to assets will be available in the Customize window. To add attributes or custom
fields to view layouts:

1. Right-click the band or header and select Customize Layout.
2. Select Attributes or Custom Fields tabs.

3. Expand the category and drag the required attribute or custom field under the
desired band.

Note: After adding these columns, the view must be refreshed to show the
values.

Rational Portfolio Manager main menu

Rational Portfolio Manager version 7.1 introduces a new main menu and toolbar
throughout the application that increases usability and simplifies user assistance.

The following tables provide descriptions of each menu item.

Table 6. File menu

Menu item Description

Open Opens the description view of the selected
element.

Open in New Window Opens the description view of the selected

element in a secondary window.

New Creates a new element below the currently
selected item in the tree.

Import/Export Imports and exports project data to and
from Microsoft® Project. (available for
projects and proposals)

History Displays the history of the currently selected
element.

Print Prints the current tree or description view.

Exit Exits the application.
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Table 7. Edit menu

Menu item Description

Cut Performs a cut operation on the currently
selected items in the tree.

Copy Copies the selected items into the clipboard.

Paste Performs a paste operation. (available after a
cut or copy operation)

Modify Opens the Modify window for multiple
selected items.

Delete Deletes the selected items in the tree.

Convert to Converts an item to a different element type.

Change State

Displays all available states for the currently
selected element, allowing you to change the
state.

Table 8. View menu

Menu item

Description

Switch to

Allows you to switch to different modules of
the application.

Portfolio Configurator

Opens the Portfolio Configurator window
where you can filter your views.

Hide Navigation Bar

Hides the left navigation bar.

Expand Expands the currently selected element.
Collapse Collapses the currently selected element.
Refresh Refreshes the currently selected element.

The Actions menu is a dynamic menu. The content of the menu is based on the
currently selected element in the active tree.

Table 9. Work Management Actions menu

Menu item Description

Check-Out Checks out the currently selected element
and opens its description view.

Check-In Checks in the currently selected element.

Check-In All

Checks in the currently selected element and
all its children.

Undo Check-Out

Checks in the currently selected element
without saving, after a check out operation.

Set as Default

Sets the currently selected project as a
default project.

Send to Archive

Archives the currently selected project.

Communications

Using the sub-menu, you can start workflow
processes, manage workflow items, send
staffing requests, and send notifications for
the currently selected element in the tree.
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Table 9. Work Management Actions menu (continued)

Menu item

Description

Calculate/Level

Using the sub-menu, you can calculate,
calculate and level and copy calculated
results for the currently selected element in
the tree.

Commit Affected Resources

Commits affected resources for the selected
project in the tree.

Copy Proposed to Plan

Copies the proposed dates into plan dates
for the selected element in the tree.

Baseline

Using the sub-menu, you can save or clear
the baseline for the currently selected
element in the tree.

Table 10. Scope Management Actions menu

Menu item

Description

Transfer Under WBS Root

Transfers the currently selected scope
element under the WBS root element.

Check-Out Checks out the currently selected element
and opens its description view.
Check-In Checks in the currently selected element.

Check-In All

Checks in the currently selected element and
all its children.

Undo Check-Out

Checks in the currently selected element
without saving, after a check out operation.

Communications Using the sub-menu, you can start workflow
processes, manage workflow items, and send
notifications for the currently selected
element in the tree.

Close Closes the Scope Management view or the

scope element description view if it is open.
This item is not available if the Scope
Management view was accessed from the
navigation bar.

Table 11. Communications view Actions menu

Menu item Description

Reply Replies to the sender of the notification.

Reply All Replies to all recipients of the notification.

Forward Forwards the notification to someone else.

Continue Continues to next workflow step.

Close Closes the currently selected notification or
process.

Archive Archives the currently selected notification
or process.

Response Opens the Step Response window where

you can submit your vote.
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Table 12. Help menu

Menu item Description

Content Opens the Rational Portfolio Manager online
help.

Welcome Displays the Rational Portfolio Manager
welcome page with a list of tutorials,
product tour, and links to other online
information.

About Displays the Rational Portfolio Manager

About window.
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Chapter 2. Status of change requests

This chapter lists known problems from previous releases of Rational Portfolio
Manager which are fixed in this release, in addition to limitations in Rational

Portfolio Manager 7.1.

Problems fixed in this release

This section lists the customer identified problems fixed in this release of Rational

Portfolio Manager.

Table 13. Customer identified problems fixed in this release

PMR ID

Description

78322 999 000; 71323 370 000

Wrong statement in online help about
considering project calendar at assignment.

933323 650 706

Verifying the installation for Tomcat, OAS,
and WebLogic application server.

92740 650 706

Installation guide typo: DNSI instead of
DNSI1.

92606 999 672

Filter of schedule variance (Latest Baseline)
under WBS plan show incorrect as WBS
variance.

91849 999 000

Fiscal month in Timephased Budgets pivot is
confusing.

90946 422 000

Staffing view does not refresh properly.

90594 999 000

Installation guide: JDBC driver settings path
in the example is not correct.

89658 49R 000

PBFS tasks stay in "Pending” state when
trying to synchronize them.

89333 999 672

Cannot remove time codes in the Timesheets
view at task level.

88507 49R 000

Wrong resources are displayed in the Skills
pivot print preview.

88334 820 820

Synchronizing imported ClearQuest tasks
return "Cannot perform a loadFromXpath on
field <Task. LASTMODIFIEDDATE>" error
message.

88022 49R 000

Workstation memory problems running
RPM pivots.

87806 820 820

When moving scope elements, incorrect
scope element’s attributes are assigned.

87805 820 820

Problem with resource’s assignment.

87175 999 672

Cannot assign resource to task in Custom
Calendar.

87018 820 820

RPMCQ: RPM client is displaying
"Unhandled error: 0" on login.

86359 010 678

Error "Security ID not found” when opening
task list in "My teams work”".
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Table 13. Customer identified problems fixed in this release (continued)

PMR ID

Description

85878 000 672

Can’t receive email workflow notifications in
the process of workflow except workflow
complete in 6212.

85763 010 678

Wrong calculate/level results for task
sequence order and for contour type
hours/day at the project level.

85687 820 820

Online Help: MSP import business rules for
actuals.

85403 49R 000

Performance issue when adding
dependencies.

85243 999 672

Constraint As Late As Possible (ALAP)
cause incorrect display of Gantt chart.

81943 999 000

DOC: The number of Closed state is not
shown under My Portal > Change Request
State Flow.

81156 49R 000

Typo in Online help Modifying the Resource
Executive Access Attribute Portlet at step 5.

80722 49R 000

Access Violation Error when right-clicking
on an element in All Summary Types filter.

80406 999 000; 85082 999 672

Scheduled Varinaces, Budget Variances and
Work Variance Filters fail to display Projects.

80282 999 672

Scope element RTF field does not show in a
report.

79312 422 000

Cost Rate incorrectly set to zero.

79075 999 672

Assign Work option is still available even if
Project Assignment Type is set to Duration.

78906 999 000

Pivot report title is missing when clicking on
the print icon.

78322 999 000

Resource remains overallocated after
leveling when project calendar has 6.5 hour
per day.

78114 49R 000

6126 PMOR2 Decommission does not make
the total zero in Financials - Worksheet.

77492 49R 000

Missing hours in Timesheet Details By
Employee.

76743 227 000

Export fails with errors 5006, 5008 in the
ImpEx log.

75470 49R 000

BMS causes discontinue date to change.

71480 370 000

The dependencies among tasks are
corrupted after adopting summary task
template.

68641 49R 000

6115: PMOR2 Adopt from Template results
in 100012 Timeout Transaction Error.

67310 000 672

Unhandled Exception EStringListError when
WBS elements are in long Chinese
Characters name.

67062 49R 000

Insufficient Work in Timesheet.
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Table 13. Customer identified problems fixed in this release (continued)

PMR ID

Description

65365 49R 000

Portfolio Configuration Window gets lost
behind RPM.

58503 999 724

Pivot "Cost Center Cross Charge with
Attributes”: rename bands for Cost Center
and Client attributes.

58005 033 000

Security: Duplicate Security Roles for same
Resource in Scope Elements.

57718 999 000

Staffing View search by Pools inaccurately
pulls up wrong data.

57697 999 724

Provide German translation of portlets
under fields tab in customize portlets
window.

57357 033 000

Timesheets Not Submitted Report is
displaying resources who have submitted
their timesheets.

56529 999 000

IBM RPM and IBM CQ Integration guide.

56138 999 616

Resource Utilization pivot inacurate data if
resource have multiple competencies.

55506 999 724

Unhandled error -1131 updating: Do Earned
Value calculation.

54025 999 616

-803 error after changing task start date.

53425 49R 000

Online Help: Typo on number of Characters
allowed in WBS.

52095 344 000

Reports generated based on Custom Fields
have data cut off.

48454 49R 000

Charge codes in Scope Elements do not
aggregate to project level.

48427 49R 000

Unable to open a zip file. (EOleException
error)

48380 49R 000

Possible Race condition With new workflow
model queries in midleware.

42721 999 000

Dragging "By Invitation” documents to
public folders.

41906 999 000

HTTP Client won’t create RPM account if
username has space in the name.

41692 999 000

Can delete Attributes in use and the deleted
attributes are showing in Investment Maps
settings window.

40917 999 000

Unhandled Error: 100, when entering
financial info.

39554 49R 000

Attribute numerical value displays as non
zero in Graph even if it equals to zero.

37604 019 000

Unhandled error -9999 in Work Management
view and Resource Management view.

35550 422 000

weekly Resource Utilization report takes 7
minutes to load.

34863 999 000

WBS element delete is very slow.
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Table 13. Customer identified problems fixed in this release (continued)

PMR ID

Description

32507 999 000

Search for template doesn’t work.

32283 999 000

Installation Guide supported platform list is
wrong.

31812 999 000

Automated Transfer to WBS generates Error
Message.

30488 999 000

Copy task from one summary task to
another, the placement of the individual task
changes order.

30415 422 000

Dialogue Box eat 100% of CPU Performance:
CPU Usage.

30020 999 760

Online help error on how to create
Organization on WBS.

29740 120 796

Cannot enter Employee Code in Employee
Information portlet of a resource.

27890 49R 000

How to do Currency Exchange Rate edits in
online help.

27794 821 821

Baselining task erases Planned Dates.

27260 49R 000

PMOR2: Unable to work with Resource
record.

24758 230 631

Reference # should not show Project ID
number.

24477 230 631

At migration to 7.0.1.1 Client Installer
deletes old RPMItray but is not installing
new RPMltray.

24437 230 631

DOC: In On-help new feature of Description
button is not documented.

22709 370 000

DOC: Timesheet approval instruction in
On-line help and RPM adim.app.view is
misleading.

17742 072 649

When attempting to re-select a calendar with
the new name and check-in the record, an
eIror occurs.

17425 49R 000

DOC: HELP file is missing information
about dependencies.

16881 033 724

Provide fix for Oracle to make the document
icons visible.

15088 000 672

Documentation needed for mail sever
configurations used in ConnectionPool.ini.

14637 001 822

DB2 -117 Database error.

14529 999 000

Can’t publish CQ-RPM Profiles.

08308 228 631

Installation Guide for RPM 6.2 misses
maximum DPI requirement for Client
installation on Windows 2000.

06643 999 760

Gantt view has interruption when forecast
date is not accepted.

05672 999 000

Inability to drag a header into a different
band.
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Table 13. Customer identified problems fixed in this release (continued)

PMR ID

Description

04556 49R 000

DOC: Scope element business rules need to
be updated.

04091 999 000

Documentation issues with OS levels.

03338 221 649

Resource assigned as CQ user cannot be
un-assigned from a CQ user.

03335 221 649

ClearQuest_Integration_category folder
missing in Custom Portlets.

03332 221 649

Profile names disappear in the ClearQuest
profile tab.

03189 999 000

The custom fields for custom portlet are not
showing from Print Preview.

02966 999 000

Getting Stream Read Error when double
clicking on zip files.

02265 49R 000

Paste link option not available for URL
elements

00642 SGC 848

Summary tasks don’t open the description
view in Timesheet.

00158 SGC 821

Online help: using the currency exchange
rate to convert to the system default one.

000002 49R 000

Inconsistency in Staffing View bands.

13854 999 000

Document Specific Binary GUI issue results
in "Unhandled exception: EVariantError”.

Known problems

This section describes known problems in this release of Rational Portfolio

Manager.

Leveling issue

When leveling a project, the leveling engine incorrectly considers the non-working
project calendar exception days. There is no workaround for this issue in this

release.

System earned value process does not consider the delay

time

The earned value delay information is not consistent when running the system
earned value process and running the "Do EV roll up" from the pop-up menu.
There is no workaround for this issue in this release.

The earned value Time Variance (TV) is not calculated

correctly

The earned value Time Variance (TV) displays the data in percentage instead of
weeks. There is no workaround for this issue in this release.

Wrong time-phased information in the Financials portlet

The time-phased data in the Financials portlet are incorrectly calculated and
displayed. There is no workaround for this issue in this release.
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Automatic time-phasing issue

When estimate dates are changed, automatic time-phasing does not recalculate the
values. There is no workaround for this issue in this release.

Saving baseline issue

When estimate values are changed and baseline is saved at the project level with
the "Add baseline delta to the project/parent" option selected, the baseline value at
the project level under Cost (WBS) is displayed incorrectly.

Downloading documents with non-ASCIl character names in
the TeamMember edition

Documents with non-ASCII character names (for example, Simplified Chinese)
cannot be downloaded using the Rational Portfolio Manager TeamMember edition.

Exporting tasks to Rational ClearQuest

When exporting Rational Portfolio Manager tasks to Rational ClearQuest, the CQ
Owner field is not populated with the resource name. There is no workaround for
this issue in this release.

Performance issue on importing large Rational Method
Composer templates

Importing large templates from Rational Method Composer can take up to 30
minutes to complete, depending on the size of the template. There is no
workaround for this issue in this release.

Requirement name limit when importing from Rational
RequisitePro

Rational Portfolio Manager imports the Rational RequisitePro Type field and Name
field as the requirement name, in this case, if the imported requirement name
(Type + Name) is more than 255 bytes, the import will fail with an internal error.

Checking out resources' timesheet

Project Managers and Resource Managers must check out and check in resources'
timesheet one at a time. If one timesheet is checked out and you check out a
second timesheet without checking in the first one, when resources open their
timesheet, it will be locked and cannot be checked out.

Incorrect counter displayed in Scope Management and
Documents view

The counter in the Filter area of the Scope Management and Documents view
displays the wrong information.

Effort loss when replacing one resource assignment with
another

When replacing a resource with another resource in the Project Resources tab of
the Staffing view, the EETC becomes red. If you right-click the assignment and
accept the EETC, the new replaced effort will be lost. However, if you reject the
EETC, the replaced effort will remain.
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Incorrect EETC and %C values in the Timesheets view

When entering EETC values for task's steps in the Timesheets view, the task's
EETC and %C values are incorrectly calculated and displayed.

RTF editing in TeamMember edition

There is a limitation in the Rational Portfolio Manager TeamMember edition that
restricts users from editing the RTF fields for a scope task from the Scheduled
Work view. For scope elements that have been converted into tasks and added to
the WBS, you need to edit the scope RTF fields from the Scope Management view.
If you attempt to edit a scope RTF field from the Scheduled Work view, the
following warning is displayed: "Editing this RTF field in Scheduled Work is not
supported. Use the corresponding property tab in Scope Elements. Contact Help
Desk with ID: 0504.0002."

Problem uploading documents using Internet Explorer in the
TeamMember edition

When uploading a document to the Rational Portfolio Manager TeamMember
edition, a browser window is presented allowing the user to browse for the
document and then upload the selected document. Using Internet Explorer, the
upload may fail if the path to the document is too long. As a workaround, upload
documents from a folder like c:\temp.

Cannot change the state of an assigned task in the
TeamMember edition

When using the Rational Portfolio Manager TeamMember edition, users are
required to have both the "Can Edit State” and "Can Close” security rights in order
to change the state of a task from the Scheduled Work view. This is different from
the native Rational Portfolio Manager client, where only the "Can Edit State”
security right is required.

RTF Editor Field cannot be editable after submitting data in
the TeamMember edition

There is a limitation in the Rational Portfolio Manager TeamMember edition that
restricts users from editing a single RTF field in any edit session. After you click
the Edit button, the selected record is in edit mode. As soon as you click an RTF
field’s tab in a property editor, that RTF field is in the edit state. If you click on
another RTF field before pressing the save button, a warning is displayed
indicating that you can only modify a single RTF field per edit session. If you want
to edit an RTF field using the Rational Portfolio Manager TeamMember edition,
you should have the desired RTF tab selected when you click the edit button.

Documents created for a scope task in Scheduled Work,
appear on the scope element task in the TeamMember edition

If you add a document to a scope element that has been converted into a task and
added to the WBS from the Scheduled Work view, the document will actually get
added to the scope element, not to the task. You will need to go to the
corresponding scope element, or to the documents view to see the document that
you have uploaded.
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Wrong %C, EETC, and Total values fields in the TeamMember
edition
When entering regular and special hours on the same day of the week, the %C,

EETC, and Total fields are not always updated properly. There is no workaround
for this issue in this release of Rational Portfolio Manager.

Cannot edit some Timesheet properties fields in the
TeamMember edition

There are some fields within the Timesheet view that are editable or visible in the
native Rational Portfolio Manager application, but are non-editable or not visible in
the Rational Portfolio Manager TeamMember edition. These issues should not keep
users from filling in their timesheets, and will be addressed in the future releases
of Rational Portfolio Manager.

Task assignment security in the TeamMember edition

When the "Can view WBS Schedule information” security right for the Task
Responsible role, is unchecked in Application Administration by Project Managers,
Rational Portfolio Manager TeamMember users cannot show the task as a planned
work in the Scheduled Work view and therefore, the checkbox to add the task to
the timesheet is disabled. Rational Portfolio Manager TeamMember users must
have the "Can view WBS Schedule information” security right.

Number and date formats in the TeamMember edition

The Rational Portfolio Manager TeamMember edition does not currently handle
locale specific number and date formats. All dates are entered and displayed in the
Universal Time Format (YYYY-MM-DD).

Uploading documents status message in the TeamMember
edition
When uploading a document to the Rational Portfolio Manager TeamMember
edition, a browser window is presented allowing the user to browse for the
document and then upload the selected document. After the document upload has
been completed, the upload document window is cleared with no status message

displayed, even though the document upload was successful. The user simply
needs to close this window and continue.

Layout editing in the TeamMember edition

In this release of Rational Portfolio Manager TeamMember edition, the layouts for
each grid view and properties view are pre-defined and non-editable. The most
commonly used fields are included in each layout. Customizing layouts will be
provided in the future release of Rational Portfolio Manager TeamMember edition.

Documents list refresh problem in the TeamMember edition

After adding a new document in the documents property tab of a scope element,
scheduled work item, or personal record, the list of documents is not always
refreshed properly when using Internet Explorer. This issue does not exist when
using Mozilla Firefox. To properly refresh the document list, you may need to
switch to another view or record and then back to the original record.
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Cannot edit Forecast Constraint Start and Finish Date in the
Timesheet view of the TeamMember edition

From the Rational Portfolio Manager TeamMember edition, users are currently
unable to edit the Forecast Constraint Start and Finish dates from the Timesheet
view. The Rational Portfolio Manager desktop application must be used to update
forecast constraint dates.

Data-centric security rules in the TeamMember edition

Rational Portfolio Manager TeamMember edition supports data-centric security
rules as opposed to user-interface-centric rules as in the desktop client. Therefore,
while a particular field may be visible in the desktop client’s grid view and appear
empty in its respective description portlet, it may be hashed-out in the Rational
Portfolio Manager TeamMember grid, in addition to the properties panel tabbed
field.

Project-level assignment security in the TeamMember edition

There is a limitation in the Rational Portfolio Manager TeamMember for
supporting of Assignment Security. While Project-level Security is fully supported,
Task-level Security is not.

Incorrect information in the Time-Phased tab of the Financials
portlet

After removing a profile assignment from a project, the Time-Phased tab in the
Financials portlet does not reflect the changes and shows incorrect information.
There is no workaround for this issue in this release.

Leveling project assignments

When leveling a portfolio with over-allocated resources, Rational Portfolio
Manager does not resolve the resource over-allocation. There is no workaround for
this issue in this release.

Pool names for profiles in the Supply/Demand pivot

The pool names for profiles in the Supply/Demand pivot are not displayed. There
is no workaround for this issue in this release.

Archiving projects in the Investment Maps view, does not
remove the element from the Work Management view

Projects that are sent to archive from the Investment Maps view, remain visible in
the Work Management view. The workaround for this issue is to refresh the Work
Management view.

ProjectConsole RGSE (RPM General Scope Elements)
collection with all attributes selected in a template

When you select all of the RGSE attributes in a domain source template and run
the collection, the ProjectConsole database is locked and no further collection is
permitted. There is no workaround for this issue in this release.
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PMR 18177 999 000; Applying iFix001 for ProjectConsole
breaks the integration between Rational Portfolio Manager and
ProjectConsole

In order to configure the RPM/ProjectConsole integration to communicate using
HTTP, users are required to modify the PJC.Properties and PJC.Properties.orig
configuration files on the ProjectConsole server, setting the flag
ALLOW_HTTP=true. Currently, when you install an update to the ProjectConsole
server (iFix, FixPack, etc.), that configuration file is getting overwritten with a new
version.

After installing any upgrades to the ProjectConsole server, you need to update the
PJC.Properties and PJC.Properties.orig files and add the ALLOW_HTTP=true flag
back in. This issue will be addressed in a future release of ProjectConsole.

Microsoft .NET version 1.1 limitations

Due to the limitation that in Microsoft .INET 1.1 C# is unable to send null values,
customers should be aware that integrations built, using the Rational Portfolio
Manager Web Services API, might experience problems when default object
property values are set to null. There is no workaround for this issue in this
release.

Microsoft .NET version 2.0 limitations

Integrations built using the Rational Portfolio Manager Web Services API with
Microsoft .NET 2.0 framework will result in experiencing problems due to the
following limitations in Microsoft .NET 2.0.

* C#is unable to decode enumeration values from the SOAP messages RPC
encoded mode.

* C# has problems decoding arrays from the SOAP messages in RPC encoded
mode.

The workaround is to use the Microsoft .NET version 1.1 framework when
developing integrations with the Rational Portfolio Manager Web Services APL

Web Service API field in the WorkElement container

All Xpath queries with the WorkElement.lastModifiedDate field must include the
timestamp portion of the date because this field is stored as a TIMESTAMP in the
database. If the time portion is not included, you will receive a database error.

Web Services API actual finish date remains null when actual
start date and actual duration are saved in minutes

When you save a WorkElement's actual start date and an actual duration in
minutes, the actual finish date should be populated on reload, however, the actual
finish date remains null. There is no workaround for this issue in this release.

Weekly Timesheet pivot

The Timesheet pivot displays two rows for some weeks when the Weekly option is
selected. There is no workaround for this issue in this release.
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Long file names in Microsoft Project

Microsoft Project files in Simplified Chinese that have a file name of more that 133
Chinese characters will fail when importing to Rational Portfolio Manager. The
workaround is to rename the file to use less that 133 characters.

PMR 71380 999 672; Workflow conditions with Chinese
characters

Rational Portfolio Manager crashes when trying to modify the workflow conditions
with Chinese characters. There is no workaround for this issue in this release.

Running Rational Portfolio Manager TeamMember and
RequisitePro integration

Users should be aware that there is a current limitation in running both Rational
Portfolio Manager TeamMember and Rational Portfolio Manager/Rational
RequisitePro integration on the same WebSphere application server. Note that this
limitation does not occur when using Apache Tomcat application server.

Rational ClearQuest and Rational RequisitePro databases

Note that Microsoft Access database cannot be used for Rational ClearQuest and
Rational RequisitePro. The supported databases are DB2 and Oracle.

Unable to set a task to a closed state using the TeamMember

edition
For the tasks listed in the Rational Portfolio Manager TeamMember edition
Scheduled Work view, none of the closed states are listed in the list of available
states when editing a task. Users can set the %DC to 100% for duration based tasks
to indicate that the task is complete. Users can also set the EETC to zero for effort
based tasks to indicate that the task is complete. However, the only way to actually
close a task is using the native Rational Portfolio Manager client.

Unable to sort by Project Name in the Scheduled Work view of
the TeamMember edition

Currently, the Scheduled Work view of the Rational Portfolio Manager
TeamMember edition cannot be sorted by Project/Initiative name. However, you
are able to filter by project name to display only the tasks that part of a specified
initiative.

Document creation in the TeamMember edition is controlled
by project level security settings

When attempting to create and attach a document to either a scope element or a
task using the TeamMember edition, the user must have the proper security rights
set on the project that contains the selected scope element or task. If the user has
document creation rights on the scope element or task element, but not on the
parent project, the create document menu in the TeamMember edition will be
disabled.
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Chapter 3. Contacting IBM Customer Support for Rational
software products

If you have questions about installing, using, or maintaining this product, contact
IBM Customer Support as follows:

The IBM Software Support Internet site provides you with self-help resources and
electronic problem submission. The IBM Software Support home page for Rational
products can be found at http://www.ibm.com/software/rational /support/.

Voice Support is available to all current contract holders by dialing a telephone
number in your country (where available). For specific country phone number, go
to http://www.ibm.com/planetwide/.

Note: When you contact IBM Customer Support, please be prepared to supply the
following information:

* Your name, company name, ICN number, telephone number, and e-mail
address

* Your operating system, version number, and any service packs or patches
you have applied

* Your database, version number, and any service packs or patches you
have applied

* Your application server, version number, and any service packs or patches
you have applied

* Product name and release number

* Your PMR number (if you are following up on a previously reported
problem)
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Appendix. Notices

This information was developed for products and services offered in the U.S.A.
IBM may not offer the products, services, or features discussed in this document in
other countries. Consult your local IBM representative for information on the
products and services currently available in your area. Any reference to an IBM
product, program, or service is not intended to state or imply that only that IBM
product, program, or service may be used. Any functionally equivalent product,
program, or service that does not infringe any IBM intellectual property right may
be used instead. However, it is the user’s responsibility to evaluate and verify the
operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter
described in this document. The furnishing of this document does not grant you
any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing

IBM Corporation North Castle Drive
Armonk, NY 10504-1785

USA.

For license inquiries regarding double-byte (DBCS) information, contact the IBM
Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106, Japan

The following paragraph does not apply to the United Kingdom or any other
country where such provisions are inconsistent with local law:
INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS
PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER
EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS
FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or
implied warranties in certain transactions, therefore, this statement may not apply
to you.

This information could include technical inaccuracies or typographical errors.
Changes are periodically made to the information herein; these changes will be
incorporated in new editions of the publication. IBM may make improvements
and/or changes in the product(s) and/or the program(s) described in this
publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for
convenience only and do not in any manner serve as an endorsement of those Web
sites. The materials at those Web sites are not part of the materials for this IBM
product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it
believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose
of enabling: (i) the exchange of information between independently created
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programs and other programs (including this one) and (ii) the mutual use of the
information which has been exchanged, should contact:

IBM Corporation
Department BCFB
20 Maguire Road
Lexington, MA 02421
US.A.

Such information may be available, subject to appropriate terms and conditions,
including in some cases, payment of a fee.

The licensed program described in this document and all licensed material
available for it are provided by IBM under terms of the IBM Customer Agreement,
IBM International Program License Agreement or any equivalent agreement
between us.

Any performance data contained herein was determined in a controlled
environment. Therefore, the results obtained in other operating environments may
vary significantly. Some measurements may have been made on development-level
systems and there is no guarantee that these measurements will be the same on
generally available systems. Furthermore, some measurement may have been
estimated through extrapolation. Actual results may vary. Users of this document
should verify the applicable data for their specific environment.

Information concerning non-IBM products was obtained from the suppliers of
those products, their published announcements or other publicly available sources.
IBM has not tested those products and cannot confirm the accuracy of
performance, compatibility or any other claims related to non-IBM products.
Questions on the capabilities of non-IBM products should be addressed to the
suppliers of those products.

COPYRIGHT LICENSE:

This information contains sample application programs in source language, which
illustrates programming techniques on various operating platforms. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM, for the purposes of developing, using, marketing or distributing application
programs conforming to the application programming interface for the operating
platform for which the sample programs are written. These examples have not
been thoroughly tested under all conditions. IBM, therefore, cannot guarantee or
imply reliability, serviceability, or function of these programs. You may copy,
modify, and distribute these sample programs in any form without payment to
IBM for the purposes of developing, using, marketing, or distributing application
programs conforming to IBM’s application programming interfaces.

Each copy or any portion of these sample programs or any derivative work, must
include a copyright notice as follows:

(c) (your company name) (year). Portions of this code are derived from IBM Corp.
Sample Programs. (c) Copyright IBM Corp. _enter the year or years_. All rights

reserved.

Additional legal notices are described in the legal_information.html file that is
included in your Rational software installation.

Trademarks
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AIX, ClearCase, ClearCase Attache, ClearCase MultiSite, ClearDDTS, ClearGuide,
ClearQuest, DB2, DB2 Universal Database, DDTS, Domino, IBM, Lotus Notes,
MVS, Notes, OS/390, Passport Advantage, ProjectConsole, Purify, Rational,
Rational Rose, Rational Suite, Rational Unified Process, RequisitePro, RUP, S/390,
SoDA, SP1, SP2, Team Unifying Platform, WebSphere, XDE, and z/OS are
trademarks of International Business Machines Corporation in the United States,
other countries, or both.

Java and all Java-based trademarks and logos are trademarks of Sun Microsystems,
Inc. in the United States, other countries, or both.

Microsoft, Windows, Windows NT, and the Windows logo are trademarks of
Microsoft Corporation in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other
countries.

Linux is a trademark of Linus Torvalds in the United States, other countries, or
both.

Other company, product or service names may be trademarks or service marks of
others.
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